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Exporting ArcScene Documents
to 3D Web Scenes
Overview

The ArcScene™ application can be used to create realistic-looking 3D
scenes, and with ArcGIS® 10.2, you can use a new geoprocessing tool,
Export To 3D Web Scene, to export your ArcScene documents to 3D web
scenes. A 3D web scene can be viewed in a browser without the need for
any plug-in. This paper provides details on the layer/data types that are
supported and the ArcScene document/layer properties that are honored in
the exported web scene. Additionally, this paper lists techniques that you
can use to improve the performance of your web scene.

What Is a 3D Web
Scene and the
CityEngine Web
Viewer?

A 3D web scene is a custom, web-optimized format that can be viewed with CityEngine®
Web Viewer and uploaded to ArcGIS Online for simple sharing. A 3D web scene can
be created in CityEngine and, at ArcGIS 10.2, you can also export your ArcScene
document (SXD) to a 3D web scene (3WS) file.
SM

CityEngine Web Viewer is a web application for viewing 3D web scenes in a browser. It
is based on WebGL technology, which allows you to view 3D content in web browsers
without installing additional plug-ins or needing a CityEngine license. More information
on CityEngine Web Viewer can be found at resources.arcgis.com/en/help/arcgisonline
/index.html#//010q000000nw000000.
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Figure 1
3D Web Scene in CityEngine Web Viewer

The Export To 3D
Web Scene
Geoprocessing Tool

The Export To 3D Web Scene geoprocessing tool exists in the 3D Analyst > CityEngine
toolset in ArcToolbox™. The 3D Analyst™ extension license is required to use this tool.
The tool takes an existing ArcScene document as input and outputs a 3D web scene file.
The 3D web scene file can be viewed locally or uploaded to ArcGIS Online or Portal for
ArcGIS to share with others.
Figure 2
The Export To 3D Web Scene Geoprocessing Tool
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Supported Data and
Layer Types

The following layer types can be exported to 3WS:

■ Feature layers (point, line, polygon, and multipatch)
■ Raster layers
■ TIN layers
LAS dataset layers and graphics layers cannot be exported to 3WS.
The table below shows the supported symbol types for point, line, and polygon layers.
Feature layers must be symbolized as one of these symbol types to be included in the
exported 3WS file. Polygon feature layers are supported both with and without layer
extrusion, but only Simple Fill symbology may be used. Point feature layers must use
3D symbology. Line feature layers must use 3D symbology or have layer extrusion
defined.
Geometry Type

ArcScene Document
Properties

Symbol Type

Point

3D Simple Marker, 3D Marker, 3D Character Marker

Line

3D Simple Line Symbol or extrusion

Polygon

Simple Fill Symbol

The following ArcScene document properties are honored in the exported 3WS file:

■ Scene coordinate system—All layers in a spatial reference that is different from the
scene will be reprojected to the scene coordinate system during export to 3WS. Only
ArcScene documents in a projected coordinate system can be exported to 3WS.

■ Area of interest (AOI)—AOI is used to limit the visual extent of your 3D scene, and
the 3WS export honors this by only processing data that falls within the defined AOI.

■ Bookmarks—All the user-defined bookmarks are preserved in the exported 3WS
file, and you can use these bookmarks to navigate in CityEngine Web Viewer.

■ Group layers—Grouping of layers in the ArcScene table of contents (TOC) is
maintained in the exported 3WS file. However, the web application will treat the
layers as alternative designs in Comparison Mode, so only one layer in a group layer
will be visible at a time. More information on the web viewer Comparison Mode can
be found at resources.arcgis.com/en/help/arcgisonline/010q
/010q000000nz000000.htm.

■ Vertical exaggeration—Setting scene vertical exaggeration in ArcScene allows you
to increase or decrease the vertical variation in your data by applying a z-factor for
all layers in the current scene document. Scene vertical exaggeration is honored in
the exported 3WS file.

Esri White Paper

3

Exporting ArcScene Documents to 3D Web Scenes
J10223

Texture
Management for 3D
Objects

Textures on 3D objects can be highly memory intensive and can also increase the size of
your 3WS files significantly. This section describes some techniques that you can use in
ArcScene to manage texture quality. It also lists the default texture properties set by the
export process to reduce the size of 3WS files.
Making use of these techniques may result in some loss in display quality, but it leads to
significant performance improvements by keeping the size of exported 3WS files smaller.
Disabling textures: If it is not important to show textures for certain layers, then disable
textures for those layers in ArcScene, and the geoprocessing tool will honor it.
In ArcScene, disable textures for a 3D textured feature layer by checking the Disable
material textures check box on the Rendering tab of the Layer Properties dialog box
(figure 3).
Texture downscaling: If you need to see some texturing detail, but not necessarily at full
resolution, then downscale the textures. Texture downscaling reduces the size of 3WS
files, based on the amount of downscaling applied.
In ArcScene, use the Quality enhancement for raster images slider to downscale textures
(figure 3).
Figure 3
Texture Management Options in ArcScene
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Automatic texture quality management in 3WS: To keep 3WS files small, all
nontransparent textures on 3D objects are automatically converted to medium-quality
JPEG format, and textures with transparency are converted to PNG format. Additionally,
textures are limited to an absolute maximum of 2,048 pixels. Please note that this is the
default behavior and cannot be configured. This is done to ensure the size of exported
3WS files will still be manageable.

Tips for Creating
ArcScene
Documents for
Export to 3WS

Listed below are some tips/recommendations on creating ArcScene documents for export
to 3D web scenes. Following these tips will improve performance of the geoprocessing
tool and help keep the size of the exported 3WS file small. The size of the 3D web scene
plays a huge role in the download and display performance of the content.
1.

Although you can add data in different coordinate systems to the same SXD, it is
good practice to have all your source data and the scene in the same coordinate
system. Having all layers in the same spatial reference system as the scene reduces
the processing time for the geoprocessing tool by removing the need for reprojecting
layers.

2.

Remove the layers that you do not want exported to 3WS. Simply turning off layers
in the ArcScene TOC will not exclude those layers from export. All supported layers
in the ArcScene document are exported, although current layer visibility is honored
in the exported 3WS. Keeping unnecessary layers in your ArcScene document will
increase the size of the 3WS file. To maintain the integrity of your original ArcScene
document, consider saving a new SXD specifically for the web scene.

3.

Define an AOI for your scene to limit the data that is exported to 3WS. The
geoprocessing tool gives a warning if no AOI is defined in the ArcScene document,
but you can still choose to execute the tool. However, this can unnecessarily increase
the size of your 3WS file, especially if you are only interested in a subset of your
data. (Note: You can also use Definition Queries for a similar result.)

4.

Limit the number of textured 3D objects in your web scenes to what is absolutely
needed. For example, when creating a 3D virtual city scene, you can have textured
3D objects in the focus area of your scene and use extruded and colored polygon
layers to represent buildings elsewhere. Doing this will still keep your web scene
realistic while reducing the size of 3WS files.

5.

Make use of texture management techniques described earlier in the paper for
textured 3D feature layers. You may have to experiment to find the combination of
texture management options that work the best for your scenario.

6.

If possible, use TINs directly as elevation sources in your SXD. Raster elevation
sources/surfaces will be automatically converted to TINs during export to 3WS, so
having surfaces already defined as TINs will speed up the export process by
removing the raster-to-TIN conversion step.
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Additionally, the Export To 3D Web Scene geoprocessing tool will use defaults that
may not be what you desire. You can use the 3D Analyst > Conversion > From TIN
> Raster to TIN geoprocessing tool to more tightly control converting your raster
surface to a TIN. As a general rule, you should use a higher tolerance value to reduce
the size of the TIN and a lower tolerance value for more detail in your TIN.
7.

As has been mentioned earlier in this paper, 3D symbology is required for feature
layers to be exported to 3WS. If your feature geometry is 3D/z-aware but the feature
layer does not have 3D symbology, then that layer will be ignored during export to
3WS and reported as a warning in the geoprocessing tool results. The sole exception
to this rule is polygon feature layers.

8.

Only use group layers when you need to perform a comparison in the web viewer.
Only one child layer in a group is visible at a time in the web viewer, so the only
benefit to grouping layers is for performing side-by-side comparisons between
sublayers. More information on group layers and Comparison Mode in the web
viewer can be found at resources.arcgis.com/en/help/arcgisonline/010q
/010q000000nz000000.htm.

9.

Field visibility for feature layers is honored in the exported 3WS. If you only want
certain attribute information to be visible when features are identified in the web
viewer, configure your layer field visibility on the Layer Properties > Fields tab
before exporting to 3WS.

10. The Hide front side of aerial features option for layer face culling is not supported in
the web viewer. The other three options available on the 3D Effects toolbar are
supported. Usually, the setting Hide back side of areal features is appropriate, but
you may want to change the layer face culling option to View both sides of areal
features if you want to guarantee seeing both sides of a feature or surface in the web
viewer.
11. Layer depth priority—The web viewer does not honor ArcScene depth priority
settings (3D Effects > Change Depth Priority), which can result in z-fighting
between layers at the same height. You can avoid z-fighting in the web viewer by
adjusting layer offsets (Layer Properties > Base heights > Layer offset) for the
problematic layers.

Viewing the 3WS
Locally

To preview the 3WS locally, you will need to do the following:
1.

Download the latest CityEngine Web Viewer to your machine from
arcgis.com/home/item.html?id=38fede3935a440e49cf316dcae6aae47.

■
■
■
■
■

Unzip the downloaded package.
Delete ceviewer.html.
Rename ceviewer_offline.html to viewer.html.
Inside the folder webviewer, create a folder named webscenes.
Place your web scene(s) (.3ws files) in the folder webscenes/.
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2.

Start a local web server:

■ Click Start > All Programs > Accessories > Command Prompt.
■ In the Command Prompt window, change the directory to your local copy of
CityEngine Web Viewer (<your download location>\webviewer).

■ Type the following in the Command Prompt window to launch a local web
server: C:\Python27\ArcGIS10.2\python –m SimpleHTTPServer
Note: You may have to change the path to the Python27 folder depending on your
ArcGIS installation options.
Note: You may use other web servers (e.g., IIS, Apache) instead of Python. This is
just an example.
3.

Open your web browser (Chrome, Firefox, or a browser that supports WebGL) and
type the following URL in the browser then press Enter:
http://localhost:8000/viewer.html?3dWebScene=../webscenes/<nameOf3wsfile>.3ws

Uploading the
CityEngine Web
Scene to ArcGIS
Online or Portal for
ArcGIS

Known Limitations
at ArcGIS 10.2.1

Once you have a local 3D web scene file, you can share your CityEngine web scene on
ArcGIS Online:
1.

Go to arcgis.com and log in to your ArcGIS Online account or log in to Portal for
ArcGIS.

2.

Once logged in, click the My Content tab.

3.

Click the Add Item button.

4.

On the Add Item dialog box, set the The item is option to On my computer.

5.

Click the Choose File button and select the 3WS file on your computer.

6.

Provide tags for your 3WS file.

7.

Click Add Item—The 3WS file will be uploaded to your ArcGIS Online account.

1.

Only ArcScene documents in a projected coordinate system can be exported to 3WS.

2.

LAS dataset and graphics layers are not exported to 3WS.

3.

Line feature layers require 3D symbology or layer extrusion to be included in the
exported 3WS.

4.

Point feature layers require 3D symbology to be included in the exported 3WS.
Extruded point feature layers are not supported.
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5.

The 3D marker symbols that have licensing/sharing restrictions are dropped from
3WS export, and the geoprocessing tool will provide a notification for each feature
layer that had a restricted 3D marker symbol. Please note that some of the 3D marker
symbols in Esri Styles also have restrictions and will not be exported to the 3WS file.

6.

Different colors for each symbol layer of a multilayer 3D marker symbol are not
honored by 3WS export. All symbol layers of a multilayer 3D marker symbol get the
same color in the exported 3WS file.

7.

Polygon feature layers (both extruded and nonextruded) should use a Simple Fill
symbol. All other symbology will appear in gray in the web scene.

8.

Layer transparency is not honored for textured multipatch layers. If you want to
make your textured multipatch layer transparent in the web viewer, you will have to
disable material textures for the multipatch layer in your ArcScene document (Layer
Properties > Rendering > Disable material textures).

9.

If the Layer Properties > Rendering > Disable material textures property is checked,
then textures and material colors in the multipatch/3D model are ignored and the
symbol color for the feature is used. If this property is not checked and the
multipatch/3D model has a nonwhite color or a texture, then the multipatch's/3D
model's color or texture is used. If this property is not checked and the multipatch/3D
model only has a white color, then the symbol color for the feature is used.

10. For raster layers, the following property in ArcScene is not honored in the exported
3WS file: Layer Properties > Symbology > Display Background Value (R, G, B).

11. For time-enabled layers, the current time stamp is not honored during export to 3WS,
and all features in the layer are exported.
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12. The web viewer does not honor a layer's depth priority defined in the ArcScene
document (3D Effects > Change Depth Priority), which may result in z-fighting
between layers at the same height.
13. Do not use the Export To 3D Web Scene geoprocessing tool with 64-bit background
geoprocessing as the results in the output 3WS may not be correct. One of the
underlying geoprocessing operations used by the geoprocessing tool does not work
well with 64-bit background geoprocessing.
14. Raster layers with layer transparency greater than 66 percent are not visible in the
web viewer. To display semitransparent raster layers, set layer transparency to be
less than or equal to 66 percent.
15. Layer transparency is not supported for TIN layers.
16. TIN layer symbols are not supported in the web scene viewer—they always appear
in green. You can, however, convert your TIN layer to a 3D polygon layer and then
apply specific colors and transparency to the 3D polygon. The workflow for this is as
follows:

■ In ArcToolbox, open the TIN Triangle geoprocessing tool: 3D Analyst Tools >
Conversion > From TIN toolset.

■ Input the TIN and run the TIN Triangle geoprocessing tool with the default
settings.

■ The output 3D polygon feature class is automatically added to the scene
document.

■ Set the symbol color for the new 3D polygon layer.
■ Set the layer transparency on the layer.
■ Save the ArcScene document.
■ Export the ArcScene document to a 3D web scene file.
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